Certification Course on CATIA
Resource Person Dr B. Sudarshan
Co-ordinator: Sri P. Siva Seshu

Date(s) of Event: 21/09/20 to 09/10/20

Organizing department: Mechanical Engineering
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Cr./KSRMCE/(Department of Mechanical Engineering)/2020-2021

Date: 14/09/2020
‘ To

‘ The Principal,

KSRM College of Engineering,

Kadapa.

Respected Sir

Sub: KSRMCE-(Department of ME) permission to conduct certification course on “CATIA”-
Request-Reg.

It is brought to your kind notice that, with reference to the cited, the ME department is
planning to conduct Certification Course on “CATIA” for B.Tech, V Sem Students from In this
regard | kindly request you to grant permission to conduct the certification course. This is
submitted for your kind perusal.

. ‘ Thanking you sir,

C}l B/ > Yours Faithfully
' ,)\><° Q} X | Sri Pz%%
VJJ} .J:}“ %‘r Asst.Prof,Dept.ME
- § 3_‘ \"'_;' 5 ,‘A
\’}I ' Vgt 2 st g KSRMCE,Kadapa.
| A S e
B - AV

To the Director for Information
To All Deans/HoD’s/IQAC
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: Kadapa,Andhra Pradesh,India-516 005 |
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Cr./KSRMCE/(Depértment of Mechanical Engineering)/2020-2021
Date: 14/09/2020

Circular .

All the B.Tech V Sem ME students are here by informed that department of MECHANICAL is
going to conduct certificate course on CATIA” interested students may register their names on
or before 19-09-2020, 5 PM '

For any queries contact faculty coordinator:

Sri P. Siva Seshu, Asst.Prof,Dept.ME, KSRMCE, Kadapa.

- gttel

Prefessor & head
Departmentof Mechnical Engineering
K.S.R.M. College of Engineering
KADAPA - 516 003,

@/ksrmce.ac.in Follow Us: ‘B & 9 /ksrmceofficial
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Prefassor & head

Departmentof Mechnical Englneering
K.S.R.M. Coliege of Engineering -
KADAPA - 516 003.



Syllabus

CATIA

01: iﬁtroduction to CATIA

02: Drawing Sketches in the Sketcher workbench -I

03: Drawing Sketches in the sketcher workbench -l

04: Constraining Sketches and Creating Base Features

05: Reference Elements and Sketch-Based Features

06: Creating Dress-Up And Hole Features

07: Editing Features

08: Transformation Features and Advanced Modeling Tools
09: Advanced Modeling Tools-II

10: 'Working With the Wireframe and Surface Design Workbench
11: Editing and Modifying Surfaces

12: Assembly Modeling

13: Working With the Drafting Workbencﬁ-l

14: Working With the Drafting Workbench-1

15: Working With Sheet Metal Components

16: DMU Kinematics (Optional)
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Department of Mechanical Engineering

Certification Course on CATIA

Timing: 4:00pm - 6:00pm

Schedule

S.No Date Course Coordinator Topic Covered
1 21-09-2020 Dr. B. Sudarshan Introduction to CATIA
2 22-09-2020 Sri P. Siva Seshu Drawing Sketches in the Sketcher workbench -I
3 24-09-2020 Dr. B. Sudarshan Drawing Sketches in the sketcher workbench -II
4 25-09-2020 Sri P. Siva Seshu Constraining Sketches and Creating Base Features
5 26-09-2020 Dr. B. Sudarshan Reference Elements and Sketch-Based Features
6 28-09-2020 Sri P. Siva Seshu .| Creating Dress-Up And Hole Features
7 30-09-2020 Dr. B. Sudarshan Editing Features, Transformation Features and Advanced
Modeling Tools
8 ]01-10-2020 | Sri P. Siva Seshu Advanced Modeling Tools-II
9 03-10-2020 Dr. B. Sudarshan Working With the Wireframe and Surface Design Workbench
10 | 04-10-2020 Sri P. Siva Seshu Editing and Modifying Surfaces
11 05-10-2020 | Dr. B. Sudarshan Working With the Drafting Workbench-|
12 06-10-2020 Sri P. Siva Seshu Working With Sheet Metal Components
13 07-10-2020 Dr. B. Sudarshan DMU Kinematics
14 08-10-2020 Sri P. Siva Seshu Assembly Modeling
15 09-10-2020 Dr. B. Sudarshan Working With the Drafting Workbench-II

Wil
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K.S.R.M.COLLEGE OF ENGINEERING
(UGC-AUTONOMOUS)
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Department of Mechanical Engineering

Activity Report

Name of the Event . Certification Coursé on CATIA
Duration of the Event + 21-09-2020 to 09-10-2020
Scheduled Time : 4.00to S.OOPM

Target Audience : B.Tech V Sem Students

Course Co oridnator . P. Siva seshu

Activity Description:

CATIA supports multiple stages of product development from conceptualization, design and engineering
to manufacturing , it is considered a software and is sometimes referred to as a 3d Product Lifecycle
Management software suite. Like most of its completion.

his company Gehry technologies was developing their Digital Project software based on CATIA.

Dept of ME organized a certificate course on CATIA , Head of the Dept , Faculty & participation of the
course inaugurated with all good spirit. Resource person being the first day first session introduction to
CATIA. The course is concluded with : DMU Kinematics., finally valedictory. Students were issued
participation certificates by the Head of the Department.

N ﬂ‘@’)B&mL

ofessor & head _
De rtmet';{of Mechnical Engineering
ﬁas R.M. Coltege of Engineering
S KADAPA - 516 003.
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CATIA Overview

- CATIA v5 is an Integrated Computer Aided
Engineering tool:
O Incorporates CAD, CAM, CAE, and other applications
Q Completely re-written since CATIA v4 and still under development
O CATIA v5 is a native Windows application
O User friendly icon based graphical user interface
O Based on Variational/ Parametric technology
- [0 Encourages design flexibility and design reuse
a Supports Knowledge Based Design
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CATIA v5 Philosophy

* A Flexible Modelling environment

O Ability to easily modify models, and implement design changes
U Support for data sharing, and data reuse

« Knowledge enabled

O Capture of design constraints, and design intent as well as final
model geometry

d Management of non-geometric as well as geometric design
information

« The 3D Part is the Master Model

O Drawings, Assemblies and Analyses are associative to the 3D
parts. If the part design changes, the downstream models with
change too.

H, City University
i ondon
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* Product Structure
« Part Design

« Assembly Design
« Sketcher

« Drafting (Interactive and
Generative)

 Wireframe and Surface

Freestyle Shaper
Digital Shape Editor
Knowledgeware
Photo Studio

4D Navigator (including
kKinematics)

Manufacturing
Finite Element Analysis

m pu}z University
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CATIA User Interface

® | P

Aenu Bar

i
H

1le Toolbar

EATIA VS &
Edit

Stat  File

=B Current

+1Baductt

: Application

S T

Iwelcome to CATIAVS - E2

FerEvETs

e

Application
Tool Bar

1

o
> e PN A

Sketcher Material Library CATIAV4AV3V2

-

CatslogEdior  Dialting  Wiefiame and Suface Design | @

Clase |

E! Do not shaw this dialog at startup
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Interactihg with CATIA (1)

« Selecting an Applicatidn

O Use the Start menu toSelect an
application

’a@, Drafting

% Product Structure

nfrastructure

Mecharical Design i

[:.7 1+ Brodici

Working with Files

O Use the File menu to create,

open, save and print

=B Edit  View Inzert

i:j_ﬂew"_ Ctrl+M

MNew fram...

DOpen... Cl+0

Llose

Save Ctrl+S

HE

Save As..
Save Al
Save All Az

New

List of Types:

Selection;

B 1 User Galasy

Exit

&9 Pint... Ctil+P

CatalogD ocument
Drawing

Fart

Process
ProcessLibrary _"J f

'@ oK_{ =;lill"-im’;:el i

Desk...
Send To

1 SelectionS. Part

Exit

niversity
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Interacting with CATIA (2)

J ';:ié, EE lNone v!‘%’ @ G%G{ @v @v @
« Display Commands « Hide/ Show
O Fly Through 0 Hide
U Fit View O Swap Visible Space
a Layer control .
Q Pan Propgr’ues
O Rotate : Q D;ple:y Charagteris}ics_for ahn
B} Zoui objec are set by se ectmg the
O N Vi entity, then pressing the right
e 'e\,N mouse button and selecting
O Standard Views Properties from the menu
O View Types: Shaded/ Hidden

Line/ Wireframe/ User Defined

CLIT]Y R
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Ma

Pan

[ Press and hold the middle
mouse button and move the
mouse to pan

Rotate

O Press and hold the middle
mouse button then the left
mouse button and move the
mouse to rotate

Zoom

U Press and hold the middle
mouse button and click the left
mouse button then move the
mouse to zoom in and out

* Using the compass

. free rotation handle

compass manipulation S, g privileged plane

handle

* Drag the axes or planes of
the compass to dynamically
rotate the display

« Multi-select entities by
holding down the Shift key

H Cn}r Hn%versfty
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More Common Commands

Copy/ Paste

d Geometry entities can be
copied and pasted from one
part to another.

L Paste Special allows you to:

« Paste a complete copy with
history

« Paste a linked copy
« Paste the result without
Iin_Ifing
Undo/ Redo

O Allows you to undo previous
actions

O Redo repeats an action that has
been undone

L

 Hide/ Show

=] 1 Allows you to temporarily hide
entities from the display

O Hidden entities can be

T recovered by clicking on the

“Swap visible space” icon, and

then selecting the entity to

make visible

- Update

O Used to update the part after
@ modification
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The Specification Tree

« The Specification Tree is displayed on the
left side of the screen while you are

working 53] Print

* Provides access to the history of how a &7 Xy plane
part was constructed, and shows the —4L7 yz plane
product structure m zx plane

« Product entities can be selected from the W@ PartBody
spec. tree or in the geometry area %] Pad.1

+ Parts can be modified by selecting them I A Sketen.
from the spec. tree. ‘OJ Hole 1

« Click on + to open a tree branch #~(, Sketch 2

« Solid Parts are stored in the PartBody
branch of the Part tree

_;:' pinnh@rsii’y




B 2
_ecture 1

|  Getting Help

« The online help library can be accessed by selecting
the Help -> Contents, Index and Search command

« The Help home page provides a search facility, and
allows you to browse by application.

- Every CATIA task has a gettlng started gwde

acﬁﬂ Infiastiucture Frameset - Microsoft Intemet Explore : ! A i
1_' File gdu View Favoites Took Hep : j
ddie @ 9 Al @ @ [EEw H = @
slcg (Back T Farie - Slo op. Refiesh  Home | Seaich Favoiles Hslqu . Pint  Edl Discuss  Realcom. it -ﬂ?‘;;{:
g_] i ke g]ﬁ stuftheWh g]c lrnz sza &)FresHo lmal @Mms f @Pmdumum sgﬂeawya @] Today's Links b_]h’abﬁdl by € Wasae
A;:dr ]@l\BSF\Dm\ nlinebasughbasughrs him TR Hl 95
F 4&‘;4 TIA
et W o pan: drag using middle mouse button. -~ To rotate: pres
CATIA Infrastructure | VVelcome to CATIA Version 5
ol FProface CATIA Version 5 is the first release of the next generation of CATIA Solutions, and addresses advanced
Tl 4 \hat's New? mechanical process centric design requirements. In addition to leading edge feature-based design
P&l J Getting Started functions, it includes highly productive capabilities for the design of mechanical assemblies and for drawing
| s o neneratinn - AUniversity
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Getting Help from the CATIA
Community

_ecilire 1

« For general information about CATIA from IBM and Dassault
Systemes refer to:
www.catia.com

* For access to the database of known problems refer to:
http://service.boulder.ibm.com/support/catia.support/databases

- The CATIA operator’s exchange provides a forum for the
exchange-of ideas and advice about using CATIA at:
WWW.CO0€.0rg

* And look at Member Center -> Forum

B#2]
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Part Design

« The Part Design application is used to create solid
models of parts

« Solid parts are usually created from 2D profiles that
are extruded or revolved to form a base feature

- The Part Design task is tightly integrated with a 2D
sketching tool

* Alibrary of features is provided to allow user to add
additional details to a base part

« Parts can be modified by selecting their features in
the specification tree

 Parts are stored in files with the extension .CATPart

%[] fcri‘t}‘,r.gr,s-.re.--si y
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Part Design

« Base Features ¢  Dress-up Features

Sketch-Based Features <] Dress-Up Features <]

28nEdedang| _SUL0E
: EI Fillets QDraft Shell
4 Pad USlot O Chamfers QThickness
J Pocket OHolg « Transformation Features
J Shatt DG"QPVe Tlansfc-rmatian Fe.uturef x|
 Reference Elements § rj‘ﬁ §§ K
Feferene Elern.. 7 | S
| . / J_.:__—,- ' ) QO Translation
| O Rotation
CI Pomt Q Mirror
O Line U Pattern
U Plane i Qg

ﬂ City University
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Sketcher

_ecture 1

* The sketcher is used to create 2D sketches of
designs, and apply constraints to the sketched
geometry

* The sketcher is now the main environment for
developing 2D profiles that will be used to build solid
models (but traditional 2D wireframe techniques are
available in the Wireframe and Surface application)

 The sketcher provides a flexible environment for
creating and modifying 2D geometry

SIENETEVE City Utiversity
"ﬁ'.:; } o ;
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Sketcher <

* Entering the sketcher

L Click on the Sketcher icon or
select Start -> Mechanical
Design -> Sketcher

« Exiting from the Sketcher

| 4 O Click on the Exit icon to leave
;F'LJ__ the sketcher and return to the
3D workspace

« Geometry Creation

Profiles [x]

oo e e

B w

Geometry Operations

Dperations =]
! RO e
e

Constraint Creation
Constiaint ~ H|

5 B &

Tools Toolbar
B oph

0 Snap to point

Q Construction Geometry
O Constraint

e H City University
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Using the Sketcher

« The Sketcher is a parametric design tool

* It allows you to quickly draw the approximate shape
of a design, and then assign constraints to complete
the shape definition

« Constraints can be applied as: Coisnl
0 Driving Dimensions — dimensions that control & EI. E?T
the size of a geometric entity . e e
d Geometric Constraints — geometric Claimes ain

- 5 ¢ O Length [J Coincidence
relationships such as parallel, perpendicular, Bl el
tangent, collinear (Osermaprans  [lPasleisn

[ Semirninor asis [ Perpendicularity
I Symmetiy [ Hoiizortalty |
%D'wréf (] Verticality

D Eau
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1. Click on the Sketcher icon 4. Apply constraints to define the
2. Select the 2D plane to sketch exact geometry required
on (may be a plane, or the face
@ of an existing part), and the
sketching window will appear 0 2
3. Sketch the profile i

¢fy | 4. Click on the exit icon to quit the
fgme sketcher |

5. Sketch is transferred into the
3D modelling environment

ey :
A

ey
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Generative Drafting =

* The Generative Drafting Application allows you to
create engineering drawings from parts or
assemblies

« Generative Drafting automatically lays out
orthographic projections of a part onto a drawing
sheet

 Traditional Drafting functions can be used to annotate
the drawing layout '

* Drawings are stored in files with the extension
.CATDrawing
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« Views Toolbar « Automatic Dimension
Views B Creation
f i : — |
‘Baap 2 DO B
_ rer—

d Create a Front View (other “ @‘ »@1
views available underneath O Auto-dimension
icon)

Lyt O Semi-Automatic Dimensions
O Create a section view

U Create a detall view
- Create a Clipping View
U Create Views Via Wizard

E City University
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Sketching Tips

e e R e e e o

To edit an existing sketch ensure that you select the sketch from
the specification tree, or select an element in the sketch. (If you
do not do this you will create a new sketch instead of modifying
the existing one)

If the sketch goes purple while you are constraining it is over-
constrained. Generally it is best to Undo the last constraint and
examine existing constraints to find the problem before
continuing

Solids can only be created from sketches that form a single
closed boundary

The profile icon allows you to create complicated profiles
including lines and arcs. See the online help for more
information

C % City University
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Creating a Solid Part from a Sketch

1. Click on the Pad icon to
7] create an extruded part

NI

2. Select the sketch containing
the profile you want to
extrude (note the sketch is
treated as a single entity)

3. The Pad definition window
will appear

T RS D
Selection: I Sketch.l |1?3 |

] Mirrored extent

More>> i

D oKk | @ Apply'] @ Carcel]
[ .

4. Select the limit type from:

U Dimension
O Up To Next
O Up To Last
O Up To Plane

. Type in the length if required

6. Check the extrude direction

arrow

. Click on OK to create the

Part

,Ei City University
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Working with Features

« The Part Design task uses intelligent design features

 The features contain information about their context as well as
their shape

« For example a Hole feature can only be created once you have
created a part body

O A hole feature requires an attachment face, and driving dimensions

O Ahole is a negative feature — it is automatically subtracted from the main
Part Body

» Other features include Pad, Revolvé, Pocket, Groove, Threéd,
Rib, Slot, Stiffener

*  When a new feature is added to a solid part it is automatically
combined with the existing part

ol e
: ;ﬁ:; T [ 1{}( (:n[y" rsity
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Modifying a Part

« All parts created in Part Design can be edited at any time in the
life of the part

« The parameters used to create a feature can be accessed by
double clicking on the feature definition in the product
specification tree or on the part geometry

« For example to change the height of a pad you should double
click on the pad node in the specification tree.

« The original feature dialogue will appear on the screen
« Change the values and click on OK.

« When you have modified the feature parameters the part will

automatically update. The part turns red briefly to indicate that it
Is out of date
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Assembly Design

« The Assembly Design application allows you to
create a product model from a number of separate
parts

« The parts in a product assembly are not joined
together, but assembled as they would be in a
physical assembly

* The product assembly structure is hierarchical and
allows you to model complex product relationships

« Constraints can be applied between the parts in
assembly to define relationships between them
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 Product Structure Tools

Product Structure Tools =]
1A, B 2n |
DS bRE EE

0028500800 0 0 0

Insert New Component
Insert New Product
Insert New Part

Insert Existing Component
Replace Component
Reorder Tree

Generate Numbers

Load Components
Unload Components
Manage Representations
Multi-Instantiation

* Move Toolbar
Move |

! ) EA
| J'\B ~
© s % A2

O

A
"

a

d
d
Q

Manipulate
Snap
Explode and Assembly

 Constraints Toolbar

Constraints E}

EBIAL IR O
Coincidence

Contact

Offset

Angular

Anchor

E:EN R

Fix Together

Cll Ty o
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Benefits of Assembly Modelling

« Support for reuse of standard parts

J Assembly design creates links to the master geometry definition, so
multiple instantiations of parts can be efficiently created

4 Design changes are automatically reflected in the assembly

 Model sizes are minimised because geometry files are not copied
* Management of inter-part relationships

U Mating Conditions

O Contact Constraints

* Development of Kinematics models

[ Simple mechanisms analysis available
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« The specification tree shows product
structure information relating to the
parts and sub-assemblies contained
In an assembly

A In the example shown on the right the

product is called Product1

O The product contains three components

CRIC_FRAME, CRIC_BRANCH_3 and
CRIC_BRANCH 1.

» The Product and the Components do
not contain any geometry -

Geometry is stored in parts inside the
Component definitions

The Constraints Branch shows the
constraints that have been created to
define the relationships between the
components in the product structure

T—@] CRIC_FRAME [CRIC_FRAME 1)

T.—%j CRIC_BRANCH_3 (CRIC_BRANCH_3.1
T—@ CRIC_BRANCH_1 (CRIC_BRANCH_1.1)
@=|]" Constraints

—'@ Surface contact.] (CRIC_BRANCH_31.C
— & Coincidence. 2 [CRIC_BRANCH_21 ORI
—B Suiface contact 3 [CRIC_BRANCH_ 110
— & Caincidence. 4 [CRIC_BRANCH_1.1.CRIL
il FisiB (CRIC_FRAME.1]

ﬂ City University
EUH | London
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> >

. Create a new CATProduct using File -> New ->
Product.

Use the Product Structure tools to lay out the main
assembly structure

Use Insert Existing Component or Insert New
Part to create geometry in the Assembly

Use Constraints to capture the design relationships
between the various parts in the assembly

ty University
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) Saving Assembly Information

1. = Assembly information is stored in a file with the
- extension .CATProduct.

t - The CATProduct file contains only information
« relating to the product assembly.

> » The detailed geometric information about the parts in

the assembly is referenced to the original .CATPart
files

Warning
| A If you copy a.CATProduct file it will still point to the original part files

¢ U To copy an entire assembly use File -> Save All As... , specify a

pl new location for the .CATProduct file, then click on the Propagate
button.

r %‘E T ICi:yVUnE'.rar'sity'
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More Advanced Part Design

* Boolean Operations

* Transforming Parts

* Assigning Materials

* Calculating Mass Properties
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Using Boolean Operations

PRIMITIVES DIFFERENCE INTERSECT

BLOCK — CYLINDER

C

YLINDER

ORIENTATION ®
CYLINDER AXIS N
NORMAL TO FACE ®

AND CENTERED %‘

ON FRONT OF
BLOCK CYLINDER — BLOCK

raliil - City University
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Using Boolean Operations

To use the traditional Boolean operations approach
to solid modelling you must create multiple bodies
within a part.

Create additional Bodies by selecting the function

Insert -> New Body

- Boolean eperations (join, subtract, intersect) can only

be applied between the main PartBody, and other
bodies in the same Part
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Transforming Parts

« Solid features can be transformed using the
transform functions

Transformation Features |

g 0 X

 Features can be mirrored, translated, rotated and
scaled

- Patterns are used to created rectangular or circular
arrays of features
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Generative Part Structural Analysis

« Mesh Specification Toolbar « Restraints Toolbar

Restrain B

Mesh Specificatiors §

O Local Mesh Size J Create Clgmp
O Create Slider

O Create Cfannectlons Bl Craata Bl Joint
@ Create Virtual Parts

« Loads Toolbar

- Equipment Toolbar
Mass [x] | @ fﬁ; @ $5 %
et %} @ O Create Pressure
O Created distributed and lumped O Create Distributed Force
masses O Create Acceleration

City University
1T Ly )
e London
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Steps for Performing an Analysis

1. Select the parts or features for analysis

2.: Define any connections, attached parts and non-
structural masses

3.1 Specify loads and restraints acting on the part
4 : Submit the job for analysis

5. Visualise Results

¢ University
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Knowledge Advisor

. CATIA stores information about a part in form of
parameters

feo

« Formula function — allows you to create new
parameters and create relationships between existing

parameters.
‘||=U-?

@ « Rules function — allows you to define design rules
relating to design parameters in a part or product

- Parameters and Relations are displayed in the
specification tree

ity University
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Generative Part Structural Analysis -

. Generative Part Structural Analysis allows you to
perform a finite element analysis on a solid part

. It is highly automated and allows an analysis to be
performed with the minimum of interaction from the

user

. Generative Part Structural Analysis provides very
limited mesh control, and can only be applied to solid
geometry | '

. Itis generally used as a “quick check” for structural
analysis
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Generative Part Structural Analysis

« Compute Toolbar « Image Toolbar

Compute B3}

Image x|
O Specify External Storage PrBR e o
0 Compute Static Solution Q Visualise Deformations
O Compute Frequency Solution O Visualise Von Mises Stresses
0 Compute Buckling Solution Q Visualise Displacements

O Visualise Principle Stresses

« Analysis Toolbar

Analysis Tools

@l H City University
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Parameters and Formulas

- CATIA V5 contains a group of applications that
provide CATIA Knowledgeware capabilities

« These tools allow you to perform design automation,
and capture non-geometric information about a
product

« The most basic Knowledgeware tool is the
Knowledge Advisor

« Using Knowledge advisor you can create parameters
and relationships relating to parts

ity University
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Knowledge Advisor Example

ﬂﬁfl Formula. 1: PartBogyiSketch. 15R adius. 15AR
i

fioet Formula.2: PadlL ] FirstLimithL 1hSecondLimitsLength

[ The value of the diameter Radius.1 is set equal to 2* the diameter
of Hole.1 in the part

: ' O The value-of the user defined parameter PadLength is set equal to
the sum of the two limits on Pad.1

.E. Clty Unlve:sﬁy
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